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Introduction

LibreOffice can be used without requiring a pointing device, such as a mouse or trackball, by
using the keyboard shortcuts that are available in Impress. Tasks as varied and complex as
docking and un-docking toolbars and windows, or changing the size or position of objects can all
be accomplished with using keyboard shortcuts. Although LibreOffice has an extensive set of
keyboard shortcuts, each LibreOffice module has keyboard shortcuts that are specific to that
module.

For help with LibreOffice keyboard shortcuts, or using LibreOffice with a keyboard only, search
the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using keyboard shortcuts that are listed in this appendix, keyboard shortcuts can
also be defined. Assign keyboard shortcuts to standard Impress functions or macros and save
them for use with Impress only, or with the other modules in LibreOffice. To customize keyboard
shortcuts, see the Getting Started Guide for more information.

Impress keyboard shortcuts

Note

Some keyboard shortcuts are not available for computers using macOS. This is
indicated in the following tables by a blank cell.

Impress functions

M{mdows macOS Effect

Linux
Switches to text edit mode and opens the Text

F2 F2 .
Formatting toolbar.

F3 F3 Enter and edit a group of objects.

Ctrl + F3 &+ F3 Exit a group of objects.

Shift + F3 Shift + F3 Opens the Duplicate dialog of a selected object.

E4 F4 Opens the Position and Size dialog of a selected
object.

Alt + Shift + F5 Alt + Shift + F5 Opens Notes view and displays the first slide in the
slide show.

Ctrl + Shift+F5 3t + Shift + F5 Opens the Navigator.

F7 F7 Start spelling checker.

Shift + F7 Shift + F7 Switches on or off the automatic spell checking.
Opens the Thesaurus dialog for the language being

Ctrl + F7 H+F7 used. Impress has to be in text editing mode to access
the thesaurus.

F8 F8 When selected, opens the Edit Points toolbar.

Ctrl + Shift + F8 &t + Shift + F8 Fit text to frame of a selected object.

F11 F+T Open the Styles deck on the Sidebar.
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Slide shows

Windows
Linux Effect
macOS

F5 Starts a slide show.

Starts a slide show at the slide where the slide show was previously stopped

Shift + F5
at.

Left click
Right Arrow
Page Down
Spacebar Shows the next slide, or plays the next animation effect on a slide.
Page down
Enter

N

Right click
Left Arrow
Up Arrow
Page Up
Backspace
P

Shows the previous slide, or plays the previous animation effect on a slide.

Home Go to first slide in the slide show.

End Go to the last slide in the slide show.

Alt + Page Up Go to the previous slide without playing any animation effects.

Alt + Page Down Go to next slide without playing any animation effects.

B or . (period) Show black screen until next key or mouse wheel event.
Esc or — (minus) Stop and close the slide show.

[Number] Enter Type the number of a slide and press Enter to show the slide.
G Increases size of the font used in Notes

S Decreases size of the font used in Notes

A Scroll up Notes

V4 Scroll down Notes

H Move caret in Notes view backward

L Move caret in Notes view forward

Ctrl+1 Show the Presenter Console

Ctrl+2 Show the Presentation Notes

Ctrl+3 Show the Slides Overview

Impress shortcuts

Vl{mdows macOS Effect
Linux
Plus (+) Zoom in.
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Windows

. macOS Effect
Linux
Minus (-) Zoom out.
Times () on Fits the slide to fill the Workspace view.
number pad
Divide (=) on Zooms in on the selected object.
number pad
Ctrl + Shift + G 3 + Shift + G Group selected objects.
Shift + Ctrl + Alt + | 3£ + Shift + Unaroun selected arou
G Option + G group group.
. . Enter a group to edit individual objects in the group.
Ctrl + click It + click Click outside the group to return to normal view.
Ctrl + Shift + G 3£ + Shift + G Combine selected objects.
Ctrl + Shift + Alt + | 38 + Shift + Split a selected object that has been combined from a
K Option + K group of two or more objects.
Ctrl + + L+ + Bring to front.
Ctrl +Shift + + I + Shift + + Bring forward.
Ctrl + - b+ - Send backward.
Ctrl + Shift + - 3£ + Shift + - Send to back.
Moves a selected object in the direction of the Arrow.
Arrow Arrow Also moves a slide within the Workspace when no
objects are selected.
Shift + Click and Shift + Click and Hold down Shift then click and drag when resizing an
drag drag object to maintain the proportions of the object.
Shift + Click and Shift + Click and Constrains movement of a selected object horizontally
drag drag or vertically when dragged.
Ctrl + Click and 3 + Click and Hold down the Ctrl (3£) key, then click and drag a
drag drag selected object to create a copy of the object.

Alt + Click and
drag

Option + Click
and drag

Hold down the Alt (Option) key and draw or resize an
object from the centre of the object.

Select an object that is behind the currently selected

Alt + Click Option + Click object.
Alt+ Shift + Click Optlon + Shift + Se_lect an object that is in front of the currently selected
Click object.
Selects several adjacent objects or characters. Click at
Shift + Click Shift + Click the start of a selection, move to the end of the
selection, and then hold down Shift while you click.
Tab Tab Select objects in the order in which they were created.
Shift + Tab Shift + Tab Select objects in the reverse order in which they were
created.
Esc Esc Exit current mode.
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Windows

. macOS Effect
Linux
Switch to the previous slide. No function on the first
Page Up X
slide.
Page Down Switch to the next slide. No function on the last slide.
Enter Enter Actlva_tte a place-h_older object in a new presentation
(only if the frame is selected).
AutoLayouts in Impress use placeholders for slide
titles, text, and objects.
To select a placeholder, press Ctrl + Enter (3£ + Enter).
Ctrl + Enter £ + Enter To move to the next placeholder, press Ctrl + Enter (3£
+ Enter) again.
If you press Ctrl + Enter (35 + Enter) after you reach
the last placeholder in a slide, a new slide is inserted
after the current slide using the same layout.
Editing text
"‘(’"d°""s macOS Effect
Linux
i i Inserts a custom hyphen in text at the cursor position.
Crl + I+ Also known as a soft hyphen.
Ctrl + Shift + - S 4 Shift + - Insgr'ts a non-breaking hyphen in text at the cursor
position. Also known as a hard hyphen.
. . Non-breaking spaces. Non-breaking spaces are not
Ctrl + Shift + It + Shift + used for hyphenation and are not expanded if the text
Space Space o
is justified.
Shift + Enter Shift + Enter Line break without paragraph change.
Left Arrow Left Arrow Moves the cursor one character to the left.
Shift + Left Arow | Shift + Left Arrow Moves the cursor one character to the left and selects

the character.

Ctrl + Left Arrow

Option + Left

Moves the cursor to the beginning of the previous

Arrow word.
Ctrl + Shift + Left Option + Shift + Moves the cursor to the left and selects the word on
Arrow Left Arrow the left.
Right Arrow Right Arrow Moves the cursor one character to the right.
Shift + Right Shift + Right Moves the cursor one character to the right and selects
Arrow Arrow the character.
Ctrl + Right Option + Right Moves the cursor to the beginning of the next word.
Arrow Arrow
Ctrl + Shift + Option + Shift + Moves the cursor to the right and selects the word on
Right Arrow Right Arrow the right.
Up Arrow Up Arrow Moves the cursor up one line.
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Windows
Linux

macOS

Effect

Shift + Up Arrow

Shift + Up Arrow

Moves the cursor up one line in the text and selects
the lines of text.

Ctrl + Up Arrow

Option + Up
Arrow

Moves the cursor to the beginning of the paragraph.

Ctrl + Shift + Up

Option + Shift +

Moves the cursor to the beginning of the paragraph.
Selects the text in the paragraph from the cursor

Arrow Up Arrow position to the beginning of the paragraph.
Down Arrow Down Arrow Moves the cursor down one line.
Shift + Down Shift + Down Moves the cursor down one line in the text and selects
Arrow Arrow the lines of text.
gx[o;erown & + Down Arrow Moves the cursor to the end of the paragraph.
Ctrl + Shift + Opt + Shift + Moves t_he cursor to the end of the paragraph._ Selects
the text in the paragraph from the cursor position to the
Down Arrow Down Arrow
end of the paragraph.
Home Moves the cursor to the beginning of the line.

Shift + Home

Moves the cursor to the beginning of the line and
selects the text from the cursor position.

Moves the cursor to the beginning of the text block on

cul + Home the slide.

End Moves the cursor to the end of the line.

Shift + End Moves the cursor to the_e_nd of the line and selects the
text from the cursor position.

ctrl + End M.oves the cursor to the end of the text block on the
slide.

Ctrl + Del Delete the text from the cursor position to the end of
the word.

Ctrl + Shift + Del Delete the text from the cursor position to the end of

the sentence.

Ctrl + Backspace

&t + Backspace

Delete the text from the cursor position to the
beginning of the word.

Ctrl + Shift +
Backspace

&£ + Shift +
Backspace

Delete the text from the cursor position to the
beginning of the sentence.

Slide Sorter and Slide Pane

mznuc:(ows macOS Effect

Home Home Set the focus to the first slide.

End End Set the focus to the last slide.

Left Arrow Left Arrow Set the focus to the previous slide.
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Windows

list.

. macOS Effect
Linux
Right Arrow Right Arrow Set the focus to the next slide.
Move selected slides down one position in Slide
Ctrl + Shift + Option +Shift + Sorter view. With multiple slides selected, the slides
Down Arrow Down Arrow are moved together with the last selected slide in the

Ctrl + Shift + Up

Option + Shift +

Move selected slides up one position in Slide Sorter
view. With multiple slides selected, the slides are

Pane.

Arrow Down Arrow moved together with the first selected slide in the list.
Ctrl + Shift + End d& + Shift + Move selected slides to end of Slide Sorter list.
Down Arrow
Ctrl + Shift + &5 + Shift + Up Move selected slides to start of Slide Sorter list.
Home Arrow
Change to Normal view with the active slide when in
Enter Enter Slide Sorter view. Add a new slide when in Slide

Menu keyboard shortcuts

The keyboard shortcuts listed in the following tables are available in each menu category on the
Menu bar. The tables give the menu item or sub-item, operating system validity, and the effect or
purpose of the shortcut.

Note
The menus listed below are in the same order as displayed on the Menu bar from left
to right.
File menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
Opens the Open file browser so you
Open Ctrl+ O d+0 can navigate to a folder and select a
document.
Save Ctrl+ S H+S Saves the open document.
Save As Ctrl + Shift + S % 4 Shift + S Opens the Save as file browser to save
the open document as a new document.
Print Ctrl+ P 3 4 p Opens the_Prln_t dialog to select how the
document is printed
Edit Menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
Undo Ctrl+Z H+z Undoes the previous editing action.
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Menu item or

Windows

sub-item Linux HEIEOL i
Redo Ctrl+ Y W 4y Reverses the action of the last Undo
command.
Deletes the selected object and places
Cut Ctrl + X b+ X it on the clipboard.
Copies the selected object to the
Copy Ctrl + C H+C clipboard,
Paste Ctrl + V 3 4y Places the object on the clipboard into
the document.
Paste Special
> Paste Ctrl + Shift + Alt | 3£ + Shift + Paste copied text at the cursor position
Unformatted +V Option + V without any formatting.
Text
. Pastes the contents of the clipboard at
Paste Special the cursor position in a format that is
> Paste Ctrl + Shift+V | 38 + Shift + v ursor pe :
X specified using the Paste Special
Special )
dialog.
Select All Ctrl + A H+A Selects all objects on a slide.
Opens the Edit Points toolbar if there is
Points F8 F8 an object on the slide that uses editable
points, for example a freeform line.
Switches on or off the Impress edit
Edit Mode Ctrl + Shift + M £ + Shift + M mode. When switched off, a slide show
is displayed in read only mode.
View menu
Menu item or Windows
sub-item Linux HEEOE S
Rulers Ctrl + Shift + R % 4 Shift + R Switches the rulers off and on in the
Workspace.
Sidebar Ctrl + F5 H+F5 Opens or closes the Sidebar.
Opens or closes the Styles deck on the
Styles F11 HB+T Sidebar.
Navigator Ctrl + Shift+F5 3 + Shift + F5 Opens the Navigator.
Insert menu
Mem_l item or M{mdows macOS Effect
sub-item Linux
Switches to text edit mode and opens
Text Box F2 F2 the Text Formatting toolbar.
Hyperlink Ctrl + K H+K Opens the Hyperlink dialog.
Comment Ctrl + Alt + C 3 + Option + Inserts a new comment box onto the
C selected slide.
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Menu item or

Windows

sub-item Linux HELELE Sl

Formatting

Mark > Insert Ctrl + Shift + 3£ + Shift + Inserts a non-breaking space at the

non-breaking Space Space cursor position.

space

Formatting

Mark > Insert .

Narrow Ctrl + Shift+F5 Ft + Shift + F5 Inserts a no- breaking space at the
cursor position.

No-break

Space

Formatting

Mark > Inserts a no-width no optional break at

No-width Ctrl +/ L +/ the cursor position.

Optional Break

Format menu

Mem_l item or Vl{lndows macOS Effect

sub-item Linux

Text > Bold Ctrl+B & +B Applies Bold format to selected text.

Text > Italic Ctrl +1 L +1 Applies Italic format to selected text.

Text > . Ctrl + Shift + P 3£ + Option + Applies superscript format to selected

Superscript C text.

Text > _ Ctrl + Shift + B P + Shift + B Applies subscript format to selected

Subscript text.

;?ZX(; > Increase Ctrl +] & +] Increases the point size of selected text.

Text > Decreases the point size of selected

Decrease Size Cul+[ L+ text.

Spac!ng > Line ctrl + 1 % 41 Set_s the !lne spacing in a paragraph to

Spacing 1 a single line.

Spac!ng Line Cirl + 5 45 Sets the line spacing in a paragraph to

Spacing 5 one and half lines.

Spac!ng > Line Ctrl + 2 3 42 Sets.the line spacing in a paragraph to

Spacing 2 two lines.

Align > Left Ctrl + L % 4L Sgts the paragraph alignment to left
aligned.

Align > Center Ctrl + E 3+ E Sgts the paragraph alignment to center
aligned.

Align > Right Cirl + R 4R Sgts the paragraph alignment to right
aligned.

Align > Sets the paragraph alignment to

Justified Curl +J E+J justified.
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Menu item or

Windows

sub-item Linux HEIEOL i
. Shift + Alt + Demotes a point to the next level when
Lists > Demote . . .
Right Arrow Outline view.
Lists > Shift + Alt + Promotes a point to the next level when
Promote Left Arrow in Outline view.
Lists > Move Shift + Alt + Shift + Option Moves a point down the order when in
Down Down Arrow + Down Arrow Outline view.
Lists > Move Shift + Alt + Up Shift + Option Moves a point up the order when in
Up Arrow + Up Arrow Outline view.
Styles > Opens or closes the Styles deck on the
Manage Styles F11 E+T Sidebar.
Object and
Shape > Opens the Position and Size dialog of a
e F4 F4 )
Position and selected object.
Size
Arrange > . . Moves a selected object to the front of
Bring to Front Ctrl + Shift + + IE + Shift + + other objects.
Arrange > Moves a selected object in front of the
Bring Forward Curl ++ FE++ forward object.
Arrange > Moves a selected object behind the
Send Ctrl + - 3+ - .
backward object.
Backward
Arrange > . L Moves a selected object to the back of
Send to Back Ctrl + Shift + JE + Shift + other objects.
Group > Group Ctrl + Shift + G 3 + Shift + G Group selected objects.
Group > Ctrl + Alt + 3+ Option +
Ungroup Shift + G Shift + G Ungroup selected group.
group > Enter F3 F3 Enter and edit a group of objects.
roup
Group > Exit . .
Group Ctrl + F3 H+F3 Exit a group of objects.
Slide menu
Mem_l item or Vl{mdows macOS Effect
sub-item Linux
New Slide Ctrl + M Ctrl + M Inserts a new slide into the slide show.
Jump to Last . Option + Shift Opens the last slide edited in the
Edited Slide Alt + Shift + F5 +F5 document.
Move > Slide to | Ctrl + Shift + Moves the selected slide to the
Start Home beginning of the slide show.
Move > Slide Ctrl + Shift + $2 + Shift + Up Movgs the _selected slld_e above thg
previous slide. No function on the first
Up Up Arrow

slide.
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Menu item or

Windows

sub-item Linux macoS Effect
Move > Slide Ctrl + Shift + £ + Shift + Moves the selected slide below the next
Down Down Down Arrow slide. No function on the last slide.
Move > Slide to Ctrl + Shift + Moves the selected slide to the end of
End End the slide show.
Navigate > To Page U Switch to the previous slide. No function
Previous Slide ge =p on the first slide.
Navigate > To Page Down Switch to the next slide. No function on
Next Slide g the last slide.
Slide Show menu
Menu item or Windows
sub-item Linux macoS Effect
glt%r; from First F5 F5 Starts a slide show from the first slide.
Start from _ _ Starts_ a slide show at th_e slide where
Current Slide Shift + F5 Shift + F5 gle slide show was previously stopped
Tools menu
Mem_l item or V|{lndows macOS Effect
sub-item Linux
Spelling F7 F7 Start spelling checker.
Autom_anc Spell Shift + E7 Shift + E7 SW|tches on or off the automatic spell
Checking checking.
Opens the Thesaurus dialog for the
Thesaurus Ctrl + E7 3 4+ F7 !anguage_ t_)elng used. Impress has to be
in text editing mode to access the
thesaurus.
Extension Ctrl+ Alt + E H+AIt+E Opens the Extension Manager dialog.
Manager
Options Alt+ F12 Opens the Options LibreOffice dialog.
Windows menu
MenL! item or Vl{lndows macOS Effect
sub-item Linux
Closes the active window. If there is
Closes Window | Ctrl + W H+w only one window, LibreOffice Impress

closes.
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Help menu

Menu item or Windows

sub-item Linux B0 et

LibreOffice = = Opens the browser application at the
Help LibreOffice Help pages.

Toolbar keyboard shortcuts

Impress provides several toolbars to help in creating slides and slide shows. Some of the tools
on these Impress toolbars can be activated using a keyboard shortcut.

Note

The toolbars are listed in the same order that is displayed in the context menu that
opens when clicking on View > Toolbars on the Menu bar.

Drawing
Windows
Tool nhame Linux Effect
macOS
Insert Text Box E2 Switches to text edit mode and opens the Text Formatting
toolbar.
gic;seltlon and F4 Opens the Position and Size dialog of a selected object.
. Opens the Edit Points toolbar if there is an object on the
Points F8 ! ; : )
slide that uses editable points, for example a freeform line.
Context Menu Shift+F10 Opens the context menu for the selected object.
Form Design
Tool name M{mdows macOS Effect
Linux
Position and Opens the Position and Size dialog of a
) F4 F4 .
Size selected object.
Bring to Front Ctrl + Shift + + I + Shift + + Moves a selected object to the front of
other objects.
Send to Back Ctrl + Shift + - S + Shift + - Moves a selected object to the back of
other objects.
Group Ctrl + Shift + G 3 + Shift + G Group selected objects.
Ctrl + Alt + 3B+ Option +
Ungroup Shift + G Shift + G Ungroup selected group.
Enter Group F3 F3 Enter and edit a group of objects.
Exit Group Ctrl + F3 H+F3 Exit a group of objects.
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Image

Arrow

+ Up Arrow

Tool name llil(mdows macOS Effect
inux
Bring to Front Ctrl + Shift + + P 4 Shift + + Moves a_selected object to the front of
other objects.
Bring Forward Cirl + + P 4 4 Moves a se;lected object in front of the
forward object.
Send Moves a selected object behind the
Backward Ctrl + - IE+- backward object.
Send to Back Ctrl + Shift + - S + Shift + - Moves a_selected object to the back of
other objects.
Line and Filling
Tool name M{' s macOS Effect
Linux
Position and Opens the Position and Size dialog of a
) F4 F4 i
Size selected obiject.
Bring to Front Ctrl + Shift + + P 4 Shift + + Moves a_selected object to the front of
other objects.
Bring Forward Ctrl + + 3P 4+ Moves a sglected object in front of the
forward object.
Send Moves a selected object behind the
Backward Ctrl + - e+ - backward object.
Send to Back Ctrl + Shift + - 3 + Shift + - Moves a selected object to the back of
other objects.
Show the .
Styles Sidebar F11 HB+T Opens the Styles deck on the Sidebar.
Outline
Tool nhame lli|{mdows macOS Effect
inux
Demote Shift + Alt + Demotes a point to the next level when
Right Arrow Outline view.
Shift + Alt + Promotes a point to the next level when
Promote . - .
Left Arrow in Outline view.
Move Down Shift + Alt + Shift + Option Moves a point down the order when in
Down Arrow + Down Arrow Outline view.
Move Up Shift + Alt + Up Shift + Option Moves a point up the order when in

Outline view.

Appendix A, Keyboard Shortcuts | 15




Slide Sorter

Slide

Tool name r{mdows macOS Effect
inux
glt%ré from First F5 F5 Starts a slide show from the first slide
Standard
Tool nhame M{' e macOS Effect
Linux

New Ctrl + N HB+N Opens a new presentation document.

Templates Ctrl + Shift + N % + Shift + N Opens the Temple_ltes dialog to create a
new document using a template.
Opens the Open file browser so you

Open Ctrl+ O H+0 can navigate to a folder and select a
document.

Save Ctrl+S H+S Saves the open document.
Opens the Save as file browser so you

Save As Ctrl + Shift + S 3 + Shift + S can save the open document as a hew
document.

Edit Mode Ctrl + Shift+M | 38+ Shift+m | SWitches on edit mode when a
document is in read only mode.

Print Ctrl+ P W4 p Opens the_Prln_t dialog to select how the
document is printed.
Deletes the selected object and places

Cut Crl + X I+ X it on the clipboard.
Copies the selected object to the

Copy Ctrl +C H+C clipboard.

Paste Cirl + V W4 v Places the object on the clipboard into
the document.

Clear D[rect Ctrl + Shift + M P 4 Shift + M Removes _dlrec'g formattl.ng that has

Formatting been applied without using styles.

Undo Ctrl+Z H+Z Undoes the previous editing action.

Redo Ctrl+ Y W 4y Reverses the action of the last Undo
command.

Find and Ctrl+ H 3t + Option + F | Opens the Find and Replace dialog

Replace '

Spelling F7 F7 Starts the spelling checker.

Toggle . Shift + F7 Shift + F7 SWltches on or off the automatic spell

Automatic Spell checking.

Start from First F5 F5 Starts a slide show.
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Windows

Tool name . macOS Effect
Linux
Start from _ _ Starts_ a slide show at th_e slide where
Current Slide Shift + F5 Shift + F5 gle slide show was previously stopped
Switches to text edit mode and opens
Insert Text Box F2 F2 the Text Formatting toolbar.
Insert Hyperlink | Citrl + K &+ +K Opens the Hyperlink dialog.
Standard (Single Mode)
Tool nhame W' i macOS Effect
Linux
New Ctrl+ N H+N Opens a new presentation document.
Opens the Open file browser for
Open Ctrl+ O #H+0 navigation to a folder and select a
document.
Save Ctrl+ S F+S Saves the open document.
Print Crl + P 3 4 p Opens the'Prln_t dialog to select how the
document is printed
Undo Ctrl+Z H+Z Undoes the previous editing action.
Redo Cirl+ Y P4y Reverses the action of the last Undo
command.
Switches to text edit mode and opens
Insert Text Box F2 F2 the Text Formatting toolbar.
Position and Opens the Position and Size dialog of a
. F4 F4 .
Size selected object.
Group Ctrl + Shift + G 3t + Shift + G Group selected objects.
Ctrl + Alt + B+ Option +
Ungroup Shift + G Shift + G Ungroup selected group.
Enter Group F3 F3 Enter and edit a group of objects.
Exit Group Ctrl + F3 H+F3 Exit a group of objects.
glt%ré from First F5 F5 Starts a slide show from the first slide.
Start from Starts a slide show at the slide where
Current Slide Shift + F5 Shift + F5 tar;e slide show was previously stopped
Standard (Viewing Mode)
Tool name Vl{mdows macOS Effect
Linux
Save As Ctrl + Shift + S 3P + Shift + S Opens the Save as file browser to save

the open document as a new document.
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Windows

Tool name . macOS Effect
Linux
Edit Mode Ctrl + Shift +M | 32+ Shift+p | Switches on edit mode when a
document is in read only mode.
Print Ctrl+ P %4 p Opens the_Prln_t dialog to select how the
document is printed.
Copies the selected object to the
Copy Ctrl+ C Fd+C clipboard.
Find and Ctrl+ H 3£ + Option + F | Opens the Find and Replace dialog
Replace '
glt%ré from First F5 F5 Starts a slide show from the first slide.
Text
Tool name M{mdows macOS Effect
Linux
Insert Text Box E2 E2 Switches to text edit mode and opens

the Text Formatting toolbar.
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